GIS Exercise 1:  Intro to ArcGIS and ArcMap

This exercise is designed to familiarize you with some of the buttons, functions and navigational tools of ArcMap.  There are several questions embedded in the steps you have to follow.  Answer these in the space provided for later reference.  

1a.  Mapping the “classes” folder on CC’s GIS Server 

1. We will begin by mapping drive letter “Y” to the classes folder on CC’s GIS server, \\Gisdataserv\classes, where all the files for this exercise reside.  This will allow you easy access to the files from the computer you are working on.  A directory on network like \\Gisdataserv\classes can also be accessed via the Connect to folder tool (which will be introduced later) without being mapped as a network drive.  However, mapping a network directory as a network drives makes it easier to access the directory.  
1b.  Navigating in Arc Map
2. From the Start menu, click Programs ( Geospatial (ArcGIS ( ArcMap to open ArcMap

· Choose An Existing Map…Browse for maps
(If you have opened ArcMap files with the machine before, ArcMap lists recently accessed ArcMap files after the Browse for maps option, as shown in the graphic below at right.)

· OK
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3. Navigate to Y:\EV311_2007\Ex_1a (i.e., \\Gisdataserv\classes\EV311_2007\Ex_1a) and select Open.
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ArcMap™ always opens with a window that asks whether to begin with a new map, open an existing map, or create a template.  Unless returning to work on an existing map, the appropriate response is to create a new map.

It is important to know that an ArcMap file does not store data.  ArcMap simply stores the paths to the data that are referenced by the map layers.  As a result, ArcMap will not display a layer if the data it references to are deleted from the disk.

4. The left-hand panel of the screen (Table of Contents) lists data layers and tables that are used by the map file, while the right-hand panel is for displaying maps and map compositions.  Note that three tabs appear at the bottom of the left-hand panel:  Display, Source, and Selection.
When the Display tab is selected, layers are shown simply by their name in the order in which they are drawn on the screen.  Layers on the bottom of the list draw first; those on top draw last.  The order in which any layer draws can be changed simply by dragging it up or down the list.  dbf tables, if present in an ArcMap file, are not listed in Display view.

The Source tab does not list the layers in the order in which they are drawn.  Instead, it organizes the layers by the folders in which the data sources referenced by the layers can be found.  It does not allow drawing order to be changed, but it does show the complete path to each layer’s source data and hence, is good for determining where particular layer’s source data are stored in the file system.  dbf tables, if present in an ArcMap file, are only listed under the Source view.

The Selection tab allows you to specify layers that can be selected with the interactive selection tool that will be introduced later.

When ArcMap can not display a layer because the data it references to are renamed or moved to a different folder, you can repair the source data path under the Display or Source view by right-clicking the layer’s name and then clicking Data ( Set Data Source,.
5. On the right-hand panel of the screen, four small buttons appear at the bottom left, [image: image2.jpg]20



.  You can use these buttons to switch between different views of the data (details in the next paragraph) [image: image3.jpg]20



, to refresh the map [image: image4.jpg]20



, and to pause the drawing of the map .[image: image5.jpg]20
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ArcMap™ provides two different ways to view a map: Data View and Layout View.  Data View can be accessed by clicking the Data View button [image: image6.jpg]20



.  It is an all-purpose view for exploring, displaying, and querying the data on your map. This view does not show map elements such as scales, neatlines, and titles.  Layout View can be accessed by clicking the Layout View button [image: image7.jpg]20



.  You want to work with Layout View when creating a presentation map.  It displays a virtual page upon which you can place and arrange map elements.  ArcMap™ runs more slowly in Layout View.  Note that Data or Layout View also can be selected from the View pull-down menu.

6. The map that you are viewing in Exercise 1a contains layers that relate to the Fountain Creek Watershed.  These data were collected and assembled in a database as a part of the Fountain Creek Watershed Plan by the Pikes Peak Area Council of Governments (PPACG).  

The Fountain Creek watershed covers all of the land area that contributes runoff to Monument and Fountain Creeks up to the point where they enter the Arkansas River.

[image: image22.jpg]Lets you selectfetures from one or more layers based on where they are located in
relation to the features in another layer.

Iwantto

selectfeatures from ]

the following layers

|Vifc_stream_gauges i‘
[Ctowns

[ciies El
that:

[are completely within

L

the features in this layer

I~ Use celerted featies (0features selected)
I Apply a buflertothe featuresin -~ metra_sreas
of. [0.000000 Meters ~

The red fetures representthe features in  metro_areas
The highlighted cyan features are selected because they
ate completely within the red features

2o 2@ Co

. G




[image: image23.jpg]2%

General| Saurce | Selection | Display Symboloay | Fields | Definiian Query | Labels | Joins & Relates |
Show,

Fomtoos— Draw categories using unique values of one field. _mpor. |
Value Fi Calor
Unique values fors ] e N e
Match to symbols in sty
Quantities [sym.. [ Value [Label [ Count |
Charts |~ |<allother values> <all other values> 0
Multiple Attributes <Heading> JURIS 16661
L FL 70
GRASS GRASS 356 ll
- IR 129
MIL MIL 2
NF NF 1474 ﬂ
[ PRIVATE PRIVATE 6273
SL SL 3524
LD WILD a3
AddAlValies | Addvalies. | Pemove | Removel | Advanced -

oK cancel | Apay |





7. Click on the boxes next to layers in the Table of Contents panel to make the data visible or not visible.

8. Click and drag the Lakes layer to right above the Elevation layer, so lakes will be drawn on top of elevation surface.

9. You can rename a layer title by right-clicking on the layer name in Table of Contents and selecting Properties from the drop-down menu.  Under the General tab in the Layer Properties window, you can type in a new title.  Alternatively, single-click the layer name in Table of Contents to highlight it and the single-click the layer name again to change layer name.  These actions change the layer name in the Table of Contents panel and the legend if present in your map layout.  They DO NOT change the file name on the disk.  

10. ArcMap™ contains an extensive set of tools, most of which are arranged more or less by function on a collection of toolbars.  A list of all available toolbars can be viewed and individual toolbars turned on and off by right-clicking in the gray area at the top of the ArcMap™ window or by selecting Toolbars from the View pull-down.
The following are three important tool bars when working with ArcMap.  Turn these three tool bars on if they are not already visible in your ArcMap window.
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Standard Toolbar
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Tools Toolbar
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Layout Toolbar

If you move the mouse over a button on a toolbar, a short description of the button will appear next to the cursor and a more detailed description at the lower left corner of ArcMap window.
Label the icons on the image below with their short descriptions:

[image: image8.jpg]



11. By clicking on the icon, you will make it active and can use it in your Data or Layout view.  When you are finished with each action, you should make sure that you have the black Select Elements arrow highlighted.  

12. Use the Zoom In tool to take a close up view of the Colorado Springs metro area.  You can either click on the image or drag a box around the area you want to zoom in on.

13. Use the Previous Extent tool to go back to the view you had.  Also try the Pan tool to move the image around and Full Extent tool to see the data in the geographic area covered by all the data layers in the map.

14. Another way to zoom to a specific layer is by right clicking over the layer in the Table of Contents panel and selecting Zoom to layer.  Do this to zoom to the geographic extent covered by layer “Fountain Creek Watershed”. 

Use the Measure tool to measure the width ____________(km) and length ____________(km) of the Fountain Creek Watershed.  The result can be found on the lower left corner of ArcMap window.
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15. Make sure that all layers are checked on except the Elevation and Hillshade layers.

1c. Identifying and selecting features and attributes 
The Attribute Table:

In addition to geometries, or ‘map’, each spatial data layer – whether a shapefile or a coverage – also stores attributes, or information, about the geometries.  For example, attributes stored for weather station points can be station ID number, temperature, wind speed, wind direction, date, time, etc.  Geometry attributes are stored in attribute tables.  To display the attribute table for a layer, right-click on the layer name in the Table of Contents panel, and then click Open Attribute Table from the pop-up menu.
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Each row in the table corresponds to a geographic feature or a record in the layer, while each column or field stores one type of attributes for all the features.  A list of the fields can be displayed by right-clicking on the layer name in Table of Contents, clicking Properties, and clicking on the Fields tab.  For now it is adequate to observe that each field has a very specific definition, the significance of which will become clear in subsequent exercises.

Feature Selection:

The fact that geographical features are tied to attribute information stored in database tables accommodates a wide variety of queries based both on the geography of features (spatial selection) and their stored attributes (non-spatial selection).  In addition, ArcMap also allows you to select features manually using the Select Features tool.  

To build a query based on feature attributes, use the Select By Attributes tool that can be opened from the Selection pull-down.  The example shown below will find all the lines in the Streams layer which Name attribute value is “Fountain Creek”.
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Although the process of building a query follows 

standard Boolean logic, the mechanics are somewhat curious.  In the Select by Attributes dialog window, first select the data layer you want to query from the Layer drop-down list and select a selection method you wan to apply (Create a new selection, Add to current selection, Remove from current selection, or Select from current selection) from the Method drop-down list.  On the field list box, double-click on the field (attribute) to be queried; next single-click on the desired operator; and then double-click on the desired value from the unique value list box next to the operator buttons (click the Get Unique Values button to populate the box with unique values stored in the selected field).  Alternatively, a value may be typed into the expression.  

Compound expression can be created using operators AND and OR.  ‘AND’ implies intersection, i.e. both conditions must be met, while the operator ‘OR’ implies union, i.e. either of the conditions but not necessarily both must be met.  The query expression "POP_90" > 9999 AND "SQ_MI" >= 50, when applied to the Metro Areas layer, will return all the metro areas with population greater than 9999 and population density greater than 50-people/sq, mi in 1990.

Note that text field values need to be single-quoted (as shown in the above Select by Attribute window), but number field values can not be quoted.

16. Use Select by Attribute to select all the stream lines with the name “Fountain Creek”.  Selected lines will be displayed in the default selection color.

Use the Measure tool to get the approximate main channel length ______________ of Fountain Creek by clicking once at a start point, once at any vertices (where the course of the river changes direction) and double-click to end your measurement.  You may need to turn off other layers to have a clear look of the river.  You will see the segment and total distance listed at the lower left corner of ArcMap window.
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Finally, calculate the sinuosity by dividing the channel length by the catchment length:______________________________
17. To clear selected features in all layers, click menu Selection and then Clear Selected Features.  To clear selected features in a particular layer, right-click the layer in Table of Contents and then click Selection( Clear Selected Features.

Clear selections made in the last step.

The Select By Location option, under the Selection pull-down, accommodates queries based on geographical relationships between features in two layers.  For example, it is possible to select all the parcels in the parcels layer that are crossed by roads in the roads layer, or to select all the buildings in a layer that lie within a specified distance of roads in another layer.  As the excerpt of options from the Select By Location tool shows, queries can be constructed from an extensive list of geographic relationships.  


18. Use Select By Location to answer this question: How many USGS stream gauges are located within metro areas in the Fountain Creek Watershed? _______
(Hint: After applying the selection, open the layer’s attribute table.  It displays at the bottom of the table how many records are selected.  This is helpful when there are too many selected features on the map to count.)
19. Clear selections made in the last step.
20. You can use Select by Attributes and Select by Location together in a proper sequence to create a selection based on both spatial and non-spatial criteria.
21. The Selection menu on the pop-up menu when right-clicking on a layer name in Table of Contents offers additional capability that complements the tools under the main Selection menu in the menu bar.  Besides clearing selected features in the layer, there are options to switch selections, i.e. toggle between all the features that are presently selected and those that are not selected, and to create a new layer from the selected features.

When selecting features using the Select Features tool, it makes the process easier if you first define layers that can be selected via either the Selection tab in Table of Contents or clicking menu Selection and then Set Selectable Layers.  To select multiple features with the Select Features tool, hold down the Shift key and click the desired features. 

22. Use the Select Features tool to select all of the USGS stream gauges within Colorado Springs city limits.

23. Right click layer USGS Stream Gauges in Table of Contents and click Open attribute table.

24. On the attribute table you will see that several rows are highlighted.  Click the Selected button at bottom of the table to display records of selected features only.  

25. Click the All button at bottom of the table to display all records.  Click the Options button at the bottom of the table and click Clear Selection to clear the selection. 

26. With the attribute table still open, right click on the STANAME field and click Sort Ascending.  Scroll down the window if need to find the row with Bear Creek near Colorado Springs, CO stored in STANAME field.  Select this row (record) by clicking on the gray box to the far left of the row.  Now, close the attribute table and notice that your selected gauge is highlighted on your map.  Clear the selected feature.

1d.  Labeling Features

Feature Labels:

Fields (attributes) in the Attribute Table are significant also because they can be used to label features on the map.  To specify the field to be used to label features, open the layer’s properties widow by right-clicking the layer in Table of Contents and then clicking Properties (or by double-clicking the layer name).  Click the Labels tab on the Layer Properties window.

In the central portion of the Labels tab is the Label Field drop-down list that shows all the fields in the layer’s attribute table.  Attribute values of the selected field will be used to label features in this layer.  You can also specify label text font styles and label placement under this tab.


To turn on labels on the map, right-click the layer name in Table of Contents and click Label Features on the pop-up menu.  Note that a check mark appears in front of Label Features on the pop-up menu to indicate that labels have been turned on.  To turn the labels off, right-click the layer name again and then click Label Features.

27. Label the cities on the map using city name and a font of size 14, black, and bold.

1e. Adding Data Layers

ArcGIS by default connects to drives on the local hard disk (e.g. the C drive).  To access data stored on a network drive, a flash drive, or a CD, you have to first connect ArcGIS to the drive using the Connect to folder tool [image: image9.jpg]



28. Click the Add Data tool [image: image10.jpg]


 .
29. If Y drive (or the drive you mapped to \\Gisdataserv\Classes) is not visible in the Look in box on the Add Data dialog window, connect ArcMap to the drive by clicking on the Connect to folder tool [image: image11.jpg]


, navigating to and clicking the Y drive on the Connect to Folder dialog window so that it is highlighted, and then clicking the OK button.  Note that it is easier to connect to a folder high up in your file hierarchy so that you have access to all folders beneath it rather than having to connect to multiple folders.
30. Navigate to: Y:\EV311_2007\Data\Ftn_Creek_Plan\Projected\Structures_and_Stations\Monitoring_Stations\Dnr\ and click to highlight fc_precip_gauges, and then click Add.


31. After the layer is added to ArcMap, change its name to “Precipitation Stations”.
32. The default symbols for the precipitation stations may not be easy to read on the map.  To change the symbol for precipitation stations, single-click the symbol in Table of Contents to open the Symbol Selector dialog window.  In the dialog window, click the Circle 2 symbol in the left box.  Click the Color box to open the color pallet and select a pink color.  Make size of the symbol 10.  Click the OK button.
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33. Use the Identify tool to tell you what the different precipitation stations are.  How close are the precipitation stations to the gaging stations?    Do you think this makes a difference in how accurately one can compare precipitation to runoff measurements?  Answer below

34. Close ArcMap.  Don’t save any changes.
1f. Using ArcCatalog

GIS data formats, like shapefiles, coverages, and geodatabases, have complex structures that involve a number of component files and, in the case of coverages, different directories.  As a consequence, it is very risky to explore and manage GIS data in Windows Explorer.  Dragging a coverage without including all its component directories and files, for example, can result in irreparable damage and even loss of the data.  ArcCatalog performs the same file management functions as Windows Explorer for GIS data, as well as facilitating preview of both geometries and associated attributes tables of GIS data and the review and revision of metadata.

Note below the side-by-side comparisons of the files that you can see in ArcCatalog vs. Windows Explorer.  In ArcCatalog, you see 15 shapefiles for the Fountain Creek Watershed, with helpful icons that graphically represent the type of data contained in each one.  However, in Windows Explorer, a look inside the very same folder for the Fountain Creek Watershed shows 93 associated files (many with strange-looking extensions).  Some component files, like *.shp and *.dbf are critical to a shapefile.  You will not be able to use a shapefile if its essential component files are missing or damaged.
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ArcCatalog knows the component files that make up a particular shapefile.  If you tried to use Windows Explorer to move valley_line.shp to another location, for example, you would divorce it from its five associated files and corrupt the shapefile.  You may also corrupt the shapefile by renaming the shapefile with Windows Explorer if you do not give the same file name to all the essential component files of the shapefile.

When you first open ArcCatalog, it looks similar to this:


ArcCatalog looks very much like Windows Explorer.  The left panel displays file directory structures, GIS servers on the Internet, etc.  Note that network drives like your Y drive, and CD drive are not shown on the directory tree.  ArcGIS does not by default connect to these drives and you have to use the Connect to folder tool to connect ArcGIS to drives that are not on your local hard disk.  When you are done working with a special directory, you can disconnect it (it does not delete the directory from the disk).  To disconnect a folder, you can select Disconnect Folder from the File menu while the folder is selected (highlighted), you can right-click on the folder and select Disconnect Folder on the pop-up menu, or you can use the Disconnect From Folder icon on the toolbar.

You can also use the Connect to folder tool to connect ArcGIS directly to directories that are located deep down in the file directory hierarchy (nested within many folders) so you don’t have to navigate down the directory tree to access them in ArcCatalog.  

Also note the panel on the right for showing the contents of selected servers and folders. This right-hand panel, or frame, is also used for displaying data contents, file previews, and data characteristics (metadata).  The three tabs along the top of the right-hand panel are useful to navigate: Contents, Preview, and Metadata.  We’ll introduce these ArcCatalog views later in another exercise.  

1g. Classifying and displaying data

35. Start ArcCatalog by click Programs ( Geospatial (ArcGIS ( ArcCatalog.  In ArcCatalog, navigate to Y:\EV311_2007 and double click Ex_1b to open this ArcMap file.

36. This map is similar to that of Ex_1a with an additional data layer, Public Lands.  You can learn the attributes of these public lands by opening the attribute table.  Right-click on the Public Lands layer in Table of Contents and open its Attribute Table.  Notice that the area, name, jurisdiction and owner are all included attributes in this table.  Close the attribute table.  The way this data layer is displayed now provides no information about the land’s attributes – all the polygons in the layer are displayed with the same symbol and you can not tell, for example, which jurisdictions they belong to.

Attributes of geographic features, quantitative (e.g. temperature, income) or qualitative (e.g. vegetation types, land ownership), can be displayed on the map using the combination of symbol type, color, size, and texture.  In the following steps you will assign an appropriate symbol to each of the public land jurisdictions to convey land jurisdiction information on the map. 

37. Right-click Public Lands layer in Table of Contents and click Properties.  Click on the different tabs to see Layer properties that can be altered.  

38. Click the Symbology tab.  This is where you can classify a layer’s attribute data and assign an easy-to-read and eye-pleasing symbol to each of the data classes.    Scroll through and take a look at the options in the Show box (left panel of the window) for classifying and displaying data.  

39. Because land jurisdiction data is qualitative (categorical) data, the appropriate classification method is one of those under the Categories group in the Show box.  Click the Unique Values method under Categories.  In the Value Field box select “JURIS” and then click on the Add All Values button at the bottom.  

40. Uncheck All other values on top of the list.

41. Under the Label column, you can type in a more descriptive label for each of the jurisdiction classes, e.g. National Forest for jurisdiction value NF, by clicking on the label until the name is highlighted and you can type over it.  

42. You can change the color scheme for the whole set of categories, or just change individual colors by double clicking on the color box and using the Symbol selector.  Chose some nice colors and click OK in the Layer Properties box.

43. Now examine the Fountain Creek watershed to determine all the agencies that have jurisdiction of lands.  List them below and circle the three largest  jurisdictions (judging by eye).
44. Close ArcMap.  Don’t save any changes.
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